May 2009
This document describes how to use the Domain Template Builder to create domain templates.
Creating Domain Templates Using the Domain Template Builder, 11g Release 1 (10.3.1)

E14139-01

Copyright © 2007, 2009, Oracle and/or its affiliates. All rights reserved.

Primary Author: Savija T.V

This software and related documentation are provided under a license agreement containing restrictions on use and disclosure and are protected by intellectual property laws. Except as expressly permitted in your license agreement or allowed by law, you may not use, copy, reproduce, translate, broadcast, modify, license, transmit, distribute, exhibit, perform, publish, or display any part, in any form, or by any means. Reverse engineering, disassembly, or decompilation of this software, unless required by law for interoperability, is prohibited.

The information contained herein is subject to change without notice and is not warranted to be error-free. If you find any errors, please report them to us in writing.

If this software or related documentation is delivered to the U.S. Government or anyone licensing it on behalf of the U.S. Government, the following notice is applicable:

U.S. GOVERNMENT RIGHTS Programs, software, databases, and related documentation and technical data delivered to U.S. Government customers are “commercial computer software” or “commercial technical data” pursuant to the applicable Federal Acquisition Regulation and agency-specific supplemental regulations. As such, the use, duplication, disclosure, modification, and adaptation shall be subject to the restrictions and license terms set forth in the applicable Government contract, and, to the extent applicable by the terms of the Government contract, the additional rights set forth in FAR 52.227-19, Commercial Computer Software License (December 2007). Oracle USA, Inc., 500 Oracle Parkway, Redwood City, CA 94065.

This software is developed for general use in a variety of information management applications. It is not developed or intended for use in any inherently dangerous applications, including applications which may create a risk of personal injury. If you use this software in dangerous applications, then you shall be responsible to take all appropriate fail-safe, backup, redundancy, and other measures to ensure the safe use of this software. Oracle Corporation and its affiliates disclaim any liability for any damages caused by use of this software in dangerous applications.

Oracle is a registered trademark of Oracle Corporation and/or its affiliates. Other names may be trademarks of their respective owners.

This software and documentation may provide access to or information on content, products, and services from third parties. Oracle Corporation and its affiliates are not responsible for and expressly disclaim all warranties of any kind with respect to third-party content, products, and services. Oracle Corporation and its affiliates will not be responsible for any loss, costs, or damages incurred due to your access to or use of third-party content, products, or services.
# Contents

**Preface** ........................................................................................................................................... ix
  - Documentation Accessibility ........................................................................................................ ix
  - Conventions ............................................................................................................................... ix

**1 Introduction**
  - 1.1 Overview of the Domain Template Builder ................................................................. 1-1
  - 1.2 About Domain and Extension Templates ........................................................................ 1-2
  - 1.3 Overview of Creating Domain Templates by Using the Domain Template Builder .... 1-3
  - 1.4 Overview of Creating Extension Templates by Using the Domain Template Builder .... 1-4
  - 1.5 Additional Tools for Creating Templates ........................................................................... 1-5

**2 Starting the Domain Template Builder**
  - 2.1 To start the Domain Template Builder on a Windows machine ........................................ 2-1

**3 Creating Domain Templates by Using the Domain Template Builder**
  - 3.1 Create a New Template ...................................................................................................... 3-1
  - 3.2 Select a Template Domain Source ..................................................................................... 3-2
  - 3.3 Describe the Template ........................................................................................................ 3-2
  - 3.4 Add or Omit Applications ................................................................................................... 3-3
  - 3.5 Add Files ............................................................................................................................. 3-4
  - 3.6 Add SQL Scripts .................................................................................................................. 3-6
    - 3.6.1 To add SQL scripts to the template ........................................................................... 3-6
    - 3.6.2 To remove SQL scripts from the template ................................................................. 3-7
  - 3.7 Configure the Administration Server .................................................................................. 3-7
  - 3.8 Configure Administrator Username and Password .......................................................... 3-8
  - 3.9 Configure Users, Groups, and Global Roles ...................................................................... 3-8
  - 3.10 Assign Users to Groups ..................................................................................................... 3-10
  - 3.11 Assign Groups to Groups .................................................................................................. 3-10
  - 3.12 Assign Users and Groups to Global Roles ....................................................................... 3-11
  - 3.13 Specify Start Menu Entries ............................................................................................... 3-11
  - 3.14 Prepare Scripts and Files with Replacement Variables ................................................... 3-12
    - 3.14.1 Replacement Variable Definitions ......................................................................... 3-13
  - 3.15 Review the Domain Template ............................................................................................ 3-14
  - 3.16 Create a Template ............................................................................................................ 3-15
4 Creating Extension Templates by Using the Domain Template Builder

4.1 Create a New Template.......................................................................................................... 4-1
4.2 Select a Template Domain Source .......................................................................................... 4-1
4.3 Describe the Template.......................................................................................................... 4-2
4.4 Add or Omit Applications...................................................................................................... 4-2
4.5 Add Files ...................................................................................................................................... 4-3
4.6 Add SQL Scripts................................................................................................................ .......... 4-3
4.7 Configuring Security Options ................................................................................................... 4-3
4.8 Prepare Scripts and Files...................................................................................................... 4-4
4.9 Review the Extension Template Settings................................................................................ 4-4
4.10 Create Your Extension Template.............................................................................................. 4-4

5 How Do I ?

5.1 How Do I Create a Custom Domain Template?.................................................................... 5-1
5.2 How Do I Create a Custom Extension Template?................................................................. 5-5
List of Figures

1–1  Domain Template Builder ........................................................................................................ 1-1
List of Tables

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1–1</td>
<td>Steps for Creating a Domain Template by Using the Domain Template Builder..........</td>
<td>1-3</td>
</tr>
<tr>
<td>1–2</td>
<td>Steps for Creating Extension Templates by Using the Domain Template Builder..........</td>
<td>1-4</td>
</tr>
<tr>
<td>3–1</td>
<td>Options for Creating Templates .............................................................................</td>
<td>3-1</td>
</tr>
<tr>
<td>3–2</td>
<td>Describe the Template ............................................................................................</td>
<td>3-3</td>
</tr>
<tr>
<td>3–3</td>
<td>Configure Users, Groups and Global Roles ................................................................</td>
<td>3-9</td>
</tr>
<tr>
<td>3–4</td>
<td>Specify Start Menu Entries ....................................................................................</td>
<td>3-12</td>
</tr>
<tr>
<td>3–5</td>
<td>List of Replacement Variables ................................................................................</td>
<td>3-13</td>
</tr>
<tr>
<td>4–1</td>
<td>Security Configuration Options Window - Parameters ...........................................</td>
<td>4-4</td>
</tr>
</tbody>
</table>
This preface describes the document accessibility features and conventions used in this
guide—Oracle Fusion Middleware Creating Domain Templates Using the Domain Template
Builder.

Documentation Accessibility

Our goal is to make Oracle products, services, and supporting documentation
accessible to all users, including users that are disabled. To that end, our
documentation includes features that make information available to users of assistive
technology. This documentation is available in HTML format, and contains markup to
facilitate access by the disabled community. Accessibility standards will continue to
evolve over time, and Oracle is actively engaged with other market-leading
technology vendors to address technical obstacles so that our documentation can be
accessible to all of our customers. For more information, visit the Oracle Accessibility

Accessibility of Code Examples in Documentation

Screen readers may not always correctly read the code examples in this document. The
conventions for writing code require that closing braces should appear on an
otherwise empty line; however, some screen readers may not always read a line of text
that consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation

This documentation may contain links to Web sites of other companies or
organizations that Oracle does not own or control. Oracle neither evaluates nor makes
any representations regarding the accessibility of these Web sites.

Deaf/Hard of Hearing Access to Oracle Support Services

To reach Oracle Support Services, use a telecommunications relay service (TRS) to call
Oracle Support at 1.800.223.1711. An Oracle Support Services engineer will handle
technical issues and provide customer support according to the Oracle service request
process. Information about TRS is available at
http://www.fcc.gov/cgb/consumerfacts/trs.html, and a list of phone

Conventions

The following text conventions are used in this document:
<table>
<thead>
<tr>
<th>Convention</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>boldface</strong></td>
<td>Boldface type indicates graphical user interface elements associated with an action, or terms defined in text or the glossary.</td>
</tr>
<tr>
<td><em>italic</em></td>
<td>Italic type indicates book titles, emphasis, or placeholder variables for which you supply particular values.</td>
</tr>
<tr>
<td><code>monospace</code></td>
<td>Monospace type indicates commands within a paragraph, URLs, code in examples, text that appears on the screen, or text that you enter.</td>
</tr>
</tbody>
</table>
This chapter provides an overview of how to create templates by using the Domain Template Builder.

Topics include:

- Section 1.1, "Overview of the Domain Template Builder"
- Section 1.2, "About Domain and Extension Templates"
- Section 1.3, "Overview of Creating Domain Templates by Using the Domain Template Builder"
- Section 1.4, "Overview of Creating Extension Templates by Using the Domain Template Builder"
- Section 1.5, "Additional Tools for Creating Templates"

1.1 Overview of the Domain Template Builder

You can create WebLogic domains by using domain and extension templates that contain the key attributes and files required for building or extending a domain. You can create templates by using the Domain Template Builder, a standalone Java application that guides you through the process of creating custom domain and extension templates. This process is illustrated in Figure 1-1.

Figure 1–1  Domain Template Builder
The Domain Template Builder is designed to be used off-line, in graphical mode only. It is not supported in console mode. Therefore, the console attached to the machine on which you are using the Domain Template Builder must support Java-based GUIs. All consoles for Windows systems support Java-based GUIs; only a subset of UNIX-based consoles support Java-based GUIs.

The product installation includes a set of predefined domain and extension templates. This set of templates includes the base WebLogic Server domain template, and various extension templates that allow you to add product features and samples to the base domain. For more information, see Oracle Fusion Middleware Domain Template Reference.

After you create your domain and add new resources and applications to it, you can use the Domain Template Builder to create a custom domain template. You can also use the Domain Template Builder to customize an existing template. For example, you may want to remove applications or add SQL scripts for additional databases. To do so, select the existing domain or template as the source for your new custom template. When your custom domain templates are complete, you can start using them to create domains by using the Configuration Wizard, WLST Offline, or the unpack command. For more information about these tools, see Section 1.5, "Additional Tools for Creating Templates."

1.2 About Domain and Extension Templates

In the context of the Domain Template Builder, the term template refers to a Java Archive (JAR) file, which contains the files and scripts required to create or extend a domain. The types of templates that can be used by the Configuration Wizard to create or extend domains include:

- Domain template—defines the full set of resources within a domain, including infrastructure components, applications, services, security options, and general environment and operating system options. You can create this type of template from an existing domain by using the Domain Template Builder or the pack command. Subsequently, you can create a domain based on the template by using the Configuration Wizard.

- The product distribution includes a base WebLogic Server domain template. This template defines the core set of resources within a domain, including an administration server and basic configuration information, infrastructure components, and general environment and operating system options. It does not include sample applications. You can use this template to create a basic WebLogic Server domain, which you can then extend with applications and services, or additional product component functionality.

- Extension template—defines applications and services that can provide additional features, such as Apache Beehive, product sample applications, or JDBC or JMS components. This type of template can be used to update an existing domain.

- Managed server template—defines the subset (within a domain) of resources that are required to create a managed server domain on a remote machine. This type of template can be created using the pack command.

The product installation includes a set of predefined domain and extension templates. This set includes the base WebLogic Server domain template and various extension templates that allow you to add component features and samples to the base domain. For more information about these templates and how they relate to each other, see Domain Template Reference.
1.3 Overview of Creating Domain Templates by Using the Domain Template Builder

To create a custom domain template by using the Domain Template Builder, select the domain or domain template from which you want to create your new domain template. You then have the option of modifying the following:

- Basic template information
- Application and domain directory contents
- SQL scripts for database configuration
- Administration server and user configuration
- Basic security configuration, such as creating users, groups, and global roles and their assignments
- Start menu entries (Windows only)
- Customized scripts and variables

Table 1–1 summarizes the steps necessary to create a domain template by using the Domain Template Builder.

<table>
<thead>
<tr>
<th>In this step</th>
<th>You</th>
</tr>
</thead>
<tbody>
<tr>
<td>Section 3.1, &quot;Create a New Template&quot;</td>
<td>Choose Create a Domain Template to create a domain template.</td>
</tr>
<tr>
<td>Section 3.2, &quot;Select a Template Domain Source&quot;</td>
<td>Select the domain template or the directory of the domain from which you want to create a domain template.</td>
</tr>
<tr>
<td>Section 3.3, &quot;Describe the Template&quot;</td>
<td>Specify a description of the template.</td>
</tr>
<tr>
<td>Section 3.4, &quot;Add or Omit Applications&quot;</td>
<td>Review and modify, if required, the list of applications to be included in the template.</td>
</tr>
<tr>
<td>Section 3.5, &quot;Add Files&quot;</td>
<td>Review and modify, if required, the files to be included in the template.</td>
</tr>
<tr>
<td>Section 3.6, &quot;Add SQL Scripts&quot;</td>
<td>Add SQL scripts for each database that you expect to be used with the domains created from this template and specify the order in which the scripts are executed.</td>
</tr>
<tr>
<td>Section 3.7, &quot;Configure the Administration Server&quot;</td>
<td>Define parameters for the administration server.</td>
</tr>
<tr>
<td>Section 3.8, &quot;Configure Administrator Username and Password&quot;</td>
<td>Specify a user name and password to be used for starting the administration server. Optionally, you can also configure additional security features by defining users and groups and assigning them to global security roles.</td>
</tr>
<tr>
<td>Section 3.13, &quot;Specify Start Menu Entries&quot;</td>
<td>Optionally, define entries for the Windows Start menu.</td>
</tr>
<tr>
<td>Section 3.14, &quot;Prepare Scripts and Files with Replacement Variables&quot;</td>
<td>Replace specific paths, filenames, and other domain environment settings with replacement variables in text files contained in the template. The Configuration Wizard later replaces the variables with exact strings to set up a specific WebLogic domain.</td>
</tr>
<tr>
<td>Section 3.15, &quot;Review the Domain Template&quot;</td>
<td>Review the settings defined in your template.</td>
</tr>
</tbody>
</table>
1.4 Overview of Creating Extension Templates by Using the Domain Template Builder

The process of creating an extension template is similar to the process of creating a domain template except that you are not prompted to configure the administration server, assign an administrator username and password, or specify Start menu entries, because these domain settings are defined in the domain to be extended.

To create an extension template by using the Domain Template Builder, you select a domain or extension template to use as the basis for the extension template. You then have the option of modifying the following:

- Basic template information, such as name and description
- Application directory contents and location
- Files to be included in the template
- SQL scripts for database configuration
- Additional security, such as creating users, groups, and global roles
- Customized scripts and variables

The Domain Template Builder creates an extension template (JAR file) that can be used to extend an existing domain.

Table 1–2 summarizes the steps for creating an extension template by using the Domain Template Builder.

<table>
<thead>
<tr>
<th>In this step</th>
<th>You</th>
</tr>
</thead>
<tbody>
<tr>
<td>Section 3.16, “Create a Template”</td>
<td>Specify the name and directory for the domain template, and launch the process that creates it.</td>
</tr>
</tbody>
</table>

Table 1–2  Steps for Creating Extension Templates by Using the Domain Template Builder

<table>
<thead>
<tr>
<th>In this step</th>
<th>You</th>
</tr>
</thead>
<tbody>
<tr>
<td>Section 4.1, “Create a New Template”</td>
<td>Choose Create an Extension Template to create an extension template.</td>
</tr>
<tr>
<td>Section 4.2, “Select a Template Domain Source”</td>
<td>Choose an extension template or a domain directory from which you want to create a domain template.</td>
</tr>
<tr>
<td>Section 4.3, “Describe the Template”</td>
<td>Enter a description for the template. If you selected an existing template as your source, the description for that template is displayed. Review the description, and modify it if necessary.</td>
</tr>
<tr>
<td>Section 4.4, “Add or Omit Applications”</td>
<td>Review and modify, if required, the list of applications to be included in your extension template.</td>
</tr>
<tr>
<td>Section 4.5, “Add Files”</td>
<td>Review and modify, if required, the list of files to be included in your extension template.</td>
</tr>
<tr>
<td>Section 4.6, “Add SQL Scripts”</td>
<td>Add SQL scripts for each database that you expect to be used with the domains created from this template and specify the order in which the scripts are executed.</td>
</tr>
<tr>
<td>Section 4.7, “Configuring Security Options”</td>
<td>Optionally, create users, groups, and roles; then, assign them to groups and global roles.</td>
</tr>
</tbody>
</table>
1.5 Additional Tools for Creating Templates

As described earlier, you can create custom domain and extension templates by using the Domain Template Builder. You can also use the following tools to create templates:

- **pack**

  This command enables you to create a template archive (.jar) file that contains a snapshot of either an entire domain or a subset of a domain. You can use a template that contains a subset of a domain to create a managed server domain directory hierarchy on a remote machine.

  For more information, see Oracle Fusion Middleware Creating Templates and Domains Using the Pack and Unpack Commands.

- **WebLogic Scripting Tool (WLST):**

  WLST is a command-line scripting interface, which you can use to interact with and configure WebLogic Server instances and domains. When WLST is offline, it enables you to create a domain or update an existing domain without connecting to a running WebLogic Server—supporting the same functionality as the Configuration Wizard.

  For more information, see Oracle Fusion Middleware Oracle WebLogic Scripting Tool.
Starting the Domain Template Builder

This section describes how to start the Domain Template Builder.

**Note:** The Domain Template Builder can be used only in graphical mode. You can create templates from the command line by using the pack command. For more information, see Oracle Fusion Middleware Creating Templates and Domains Using the Pack and Unpack Commands.

### 2.1 To start the Domain Template Builder on a Windows machine

Do one of the following:

- From the Start menu, choose Start > Programs > Oracle WebLogic > WebLogic Server > Tools > Domain Template Builder.
  
The Create a New Template window is displayed.

- From a command prompt window:
  1. Go to the common\bin subdirectory of the product installation directory.
  2. Run the config_builder command.

To start the Domain Template Builder on a UNIX machine:

**Note:** The console attached to the machine on which you are running the Domain Template Builder must support Java-based GUIs.

1. Log on to the target system.
2. Open a command shell.
3. Go to the common/bin subdirectory of the product installation directory.
4. Run the following script: `sh config_builder.sh`. 
To start the Domain Template Builder on a Windows machine
Creating Domain Templates by Using the Domain Template Builder

The following topics describe how to create a domain template:

- Section 3.1, "Create a New Template"
- Section 3.2, "Select a Template Domain Source"
- Section 3.3, "Describe the Template"
- Section 3.4, "Add or Omit Applications"
- Section 3.5, "Add Files"
- Section 3.6, "Add SQL Scripts"
- Section 3.7, "Configure the Administration Server"
- Section 3.8, "Configure Administrator Username and Password"
- Section 3.9, "Configure Users, Groups, and Global Roles"
- Section 3.13, "Specify Start Menu Entries"
- Section 3.14, "Prepare Scripts and Files with Replacement Variables"
- Section 3.15, "Review the Domain Template"
- Section 3.16, "Create a Template"

3.1 Create a New Template

The Create a New Template window is displayed when you start the Domain Template Builder as described in Chapter 2, "Starting the Domain Template Builder."

Table 3–1 describes the options that this window provides.

<table>
<thead>
<tr>
<th>Choose this option</th>
<th>When you want to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a Domain Template</td>
<td>Create a template that defines the full set of resources within a domain, including infrastructure components, applications, services, security options, and general environment and operating system parameters. You can the template that you create, as the basis for creating a domain by using the Configuration Wizard, WLST, or the unpack command.</td>
</tr>
</tbody>
</table>
3.2 Select a Template Domain Source

The Select a Template Domain Source window prompts you to choose the domain or domain template from which you want to create a domain template.

To select an existing domain as the source for the new template:

1. Select the Select a Domain tab.
2. Navigate to the directory of the domain from which you want to create a domain template. Valid domain directories are indicated by the Domain directory folder icon.
3. Click Next.

The Domain Template Builder verifies that the directory you selected contains a valid domain.

---

**Note:** If the directory does not contain a valid domain, an error message is displayed.

---

To select a domain template as the source for the new template:

1. Select the Select a Template tab.
2. From the list of templates displayed in the Templates pane, select a template.
   
   The templates displayed for selection are located in the directory specified in the Locate Additional Templates pane. If you want to change the directory, click Browse, and then navigate to the appropriate directory or enter the path manually.
3. Click Next.

The Describe the Template window is displayed.

3.3 Describe the Template

The Describe the Template window prompts you to provide a description for the template.

---

**Note:** This description is displayed in the Select a Template pane of the Select a Template Domain Source window.
If you selected a domain as the source for the new template, enter the information required for the domain, and click Next.

If you selected a template as the source for the new template, information about the selected template is displayed. Review the information, and, if necessary, change it to suit the requirements of your domain. Then, click Next.

Table 3–2 describes the fields in the Describe the Template window.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>*Name</td>
<td>Enter a valid name for the domain template. The name must be a string of characters, and can include spaces.</td>
</tr>
<tr>
<td>Author</td>
<td>Enter the name of the author of the template. The name must be a string of characters, and can include spaces.</td>
</tr>
<tr>
<td>Category</td>
<td>Enter the name of the category in which you want this template to be displayed. The name must be a string of characters, and can include spaces.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description of the domain template. The name must be a string of characters, and can include spaces.</td>
</tr>
</tbody>
</table>

3.4 Add or Omit Applications

The Add or Omit Applications window is displayed only if applications are included in the template or domain selected in Section 3.2, "Select a Template Domain Source."

The Add or Omit Applications window enables you to do the following tasks:

- Review the list of applications that are currently defined in your template source
- Review the paths of the current and imported applications.
- If necessary, change the relative path for the directory into which applications are imported.
- If necessary, omit applications from the list of files to be imported.

By default, the Domain Template Builder includes applications from the domain or template you specified as the source for the template that you are creating. For example:

- If you selected a **template** as the source for the new template, and if the source template has a separately defined applications directory, all the application files defined in the applications directory are included by default.
- If you selected a **domain** as the source for the new template, applications that fulfill the following conditions are included by default:
  - Applications that are defined in the *config.xml* file by using the *app-deployment* element
  - Applications that are not considered internal applications in your product installation are included by default

Note: Fields marked with an asterisk are required.
To add applications in (or omit them from) the template:

1. In the Applications pane, review the list of applications to be included in your template. By default, all the applications are selected. The applications displayed reside in the directory specified in the Current Application Path field. The applications are copied into your template from this location.

2. To change the relative path of the directory into which an application is imported, do the following:
   a. Select the application in the Applications pane.
   b. In the Imported Application Path field, enter the relative path you want to use after the application is imported into your template.

3. Deselect the check box for any application that you do not want to include in the template.

4. Click Next.
   The Add Files window is displayed.

### 3.5 Add Files

By default, the Domain Template Builder includes files from the domain or template you specified as the source for the new template.

- If you selected an existing template as the source for the new template, all files from the source template are automatically included. If the existing template defines a separate applications directory, the applications in the template are listed under the Applications Root Directory in the Current Template View pane.
- If you selected a domain as the source for your new template, the following files and directories are included by default:

---

**Note:** When you create or extend a clustered domain (by using the Configuration Wizard or WLST) based on a template that contains applications with application-scoped JDBC or JMS resources, you might need to perform certain additional steps after creating or extending the domain. These steps are necessary to ensure that the application and its application-scoped resources are targeted and deployed properly. For more information about targeting and deploying application-scoped modules, see "Deploying Applications and Modules with weblogic.deployer" in *Oracle Fusion Middleware Deploying Applications to Oracle WebLogic Server*.  

**Note:** Some of the applications listed in the Applications pane may be included with the WebLogic products. You cannot change the relative paths for these applications. When you select these applications in the Applications pane, the Imported Application Path field is replaced by an Internal Application Path. Because these files are installed on your system during your product installation, they are not copied into the template at template creation time. When you create a domain by using this template, this path points to the application files located in your product installation directory.

---
All files in the root directory with the following extensions: .cmd, .sh, .xml, .properties, and .ini

Any files with the .pem extension defined in the SSL configuration for your domain

bin directory

lib directory

All files in the security directory that are not created automatically during domain creation

For example, in WebLogic, XACMLRoleMapperInit.ldift is not created automatically, and therefore is included in the template by default when creating a template. The XACMLAuthenticatorInit.ldift file is included by default while creating a domain in AquaLogic Service Bus.

All files and subdirectories in the config directory that are not included by the Domain Template Builder automatically during template creation. For example, config.xml and any JDBC and JMS resources defined in config.xml are not displayed in the Current Template View pane by default because the Domain Template Builder includes them in the template, automatically, during template creation.

Note: The servers directory is not included in the template by default. If you have configured additional security data such as users, groups, or roles, through the WebLogic Server administration console or other online tools, it is stored in the LDAP server and is not included in the template. You must export the data first and then import it into the target domain.

You might also need to include other files from your domain or file system that are required by the applications.

The Add Files window lets you to review, add, or remove files in the template.

- To view the current list of files in your template, expand the Domain Root Directory and Applications Root Directory in the Current Template View pane.

- To add a file, navigate to the file within the File System View pane and select Add File. You can limit the files displayed in this pane by using the filters available in the Show File Types drop-down list. For example, to display only files with the .cmd extension, select * .cmd from the drop-down list.

- To remove a file, select the file from the Current Template View pane, and select Remove File.
After adding and removing files as necessary, click Next. The Add SQL Scripts window is displayed.

### 3.6 Add SQL Scripts

You can add your own SQL scripts to the new template, so that the scripts are available when you create a domain based on the template.

**Note:** SQL scripts that are included with the product do not need to be added to the template.

The Add SQL Scripts window prompts you to add SQL scripts for each database that you expect to be used with the domains created from this template. You can also specify the order in which the scripts are executed. When you create a domain based on this template, the databases and associated SQL scripts that you include are displayed in the Run Database Scripts window of the Configuration Wizard.

**Note:** If you use a template as basis for the new template, SQL files that are included in the source template are displayed in the Selected Database Scripts pane, organized by database type.

### 3.6.1 To add SQL scripts to the template:

1. In the Database Type and Version pane, select a database from the Type drop-down list.
2. Select the database version from the Version drop-down list or enter a version number directly in the field.
3. Click Add SQL File.
   
   The Open dialog box is displayed.
4. Navigate to the directory that contains the SQL scripts for the selected database.
5. Select the SQL files to be added, and click Add SQL File(s).
   
   The SQL files that you added are displayed in the Selected SQL Files pane. The Selected Database Scripts pane displays a tree-view of all the databases and associated SQL scripts included in the template.
You can change the order in which the SQL files are executed by using the Up and Down arrow icons. The specified sequence is reflected in the **Selected Database Scripts** pane.

6. Repeat steps 1 through 6 for each database for which you want to include SQL files.

7. Click **Next**.

### 3.6.2 To remove SQL scripts from the template

Do the following:

1. From the **Type** drop-down list in the **Database Type and Version** pane, select the database for which you want to remove SQL scripts.

2. Select the database version from the **Version** drop-down list or enter a version number directly in the field.

   The SQL scripts for the selected database displayed in the **Selected Database Scripts** pane are listed in the **Selected SQL Files** pane.

3. In the **Selected SQL Files** pane, select the SQL file to be removed and click **Remove SQL File**.

4. Repeat steps 1 through 3 for each SQL script that you want to remove.

5. Click **Next**.

   The **Configure the Administration Server** window is displayed.

---

**Note:** If you are creating an extension template, the next window that is displayed is Security Configuration Options. For more information, see Configuring Security Options.

---

### 3.7 Configure the Administration Server

In every domain, one server must be designated as the administration server, the central point from which the whole domain is managed.

You can access the administrator server by using the following URL:

```
protocol://listen-address:listen-port
```

The protocol can be any of the following: t3, t3s, http, https.

You can define the **listen-address** and **listen-port** for the administration server in the **Configure the Administration Server** window of the Domain Template Builder.

For information about the fields of the **Configure the Administration Server** window, see "Configuring the Administration Server" in Oracle Fusion Middleware Creating Domains Using the Configuration Wizard.

After configuring the administration server, click **Next**.

The **Configure Administrator Username and Password** window is displayed.
3.8 Configure Administrator Username and Password

When you create a domain template, the administrator username and password from the original domain or template are included in your new template. You can modify this username and password if required.

In addition, you can provide extra security for application resources using the following security features:

- Users and groups: Classification of individuals and groups of individuals who may be granted a security role. Typically, a group is a collection of users who share a role or function within a company, such as working in the same department.
- Global security roles: Dynamically computed privileges that are used to restrict access to WebLogic resources. These privileges are granted to or withheld from users according to the roles that they are assigned.

To modify the administrator username and password:

1. Specify a valid username in the Username field by clicking within the field and modifying the string displayed there. This name is used to start the Administration Server and connect to it.
   Do not use commas or any characters in the following comma-delimited list: \t, < >, #, |, &?, ( ), { }. User names are case sensitive.

2. Specify a valid password in the User password field by clicking within the field and modifying the string displayed there. A valid password must contain at least 8 case-sensitive characters. The password value is encrypted.

3. Reenter the password in the Confirm user password field.

4. Optionally, enter a login description for this username.

5. If you want to configure additional users, groups, and global roles, select Yes at the bottom of the window, and click Next. The Section 3.9, "Configure Users, Groups, and Global Roles" window is displayed.
   If you do not want to configure additional users, groups, and global roles, select No, and click Next. The Section 3.13, "Specify Start Menu Entries" window is displayed.

3.9 Configure Users, Groups, and Global Roles

The Configure Users, Groups and Global Roles window is displayed in the Domain Template Builder in the following circumstances:

- You are creating a domain template and you selected the option to configure users, groups, and global roles in the Configure Administrator Username and Password window.
- You are creating an extension template and you selected Yes in the Security Configurations Option window.

Users, groups, and global roles are defined as follows:

Note: Do not use the password=weblogic in a production environment.
A user is an entity that can be authenticated. The user can be a person or a software entity, such as a Java client. Each user is given a unique identity within a security realm.

A group is a collection of users who usually have something in common, such as that they are working in the same department in a company.

A security role is a privilege granted to users or groups based on specific conditions. Like groups, security roles allow you to restrict access to WebLogic resources for multiple users simultaneously. A security role that applies to all WebLogic resources deployed within a security realm (and, thus, within the entire WebLogic Server domain) is called a global role.

The **Configure Users, Groups and Global Roles** window prompts you to define users, groups, and roles for authentication purposes. You must define at least one user.

To configure users, groups, and global roles:

1. Select the **User** tab and review the current user configuration. Add or change entries as required for your domain. To delete a user, click in any of the fields of the relevant row, and click Delete.

2. Select the **Group** tab and review the current group configuration. Add or change the entries required for your domain. To delete a group, click in any of the fields of the relevant row, and click Delete.

3. Select the **Role** tab and review the current role configuration. The predefined list of WebLogic Server global security roles is displayed. Add or change the entries required for your domain by using the guidelines provided in Table 3–3. To delete a role, click in any of its fields of the relevant row, and click Delete.

**Note:** Depending on the template or domain selected, one or more users, groups, or roles may be defined already. In addition, WebLogic Server defines a default set of groups and roles. For a list of the default groups and roles defined in WebLogic Server, see Users, Groups, and Security Roles in Securing WebLogic Resources Using Roles and Policies.

**Note:** Do not make the default global security roles for administrative and server resources more restrictive. If you eliminate any existing security roles, you risk degrading WebLogic Server operation. You can, however, make the default security roles more inclusive (for example, by adding new security roles).

**Table 3–3 Configure Users, Groups and Global Roles**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name*</td>
<td>Enter a valid name for the role. Do not use blank spaces, commas, hyphens, or any characters in the following comma-delimited list: \t, &lt; , #,</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description of the role to be used for informational purposes only</td>
</tr>
</tbody>
</table>
When you finish updating your settings, click **Next**.

The *Section 3.10, "Assign Users to Groups"* window is displayed.

### 3.10 Assign Users to Groups

The **Assign Users to Groups** window prompts you to assign users to groups. It is recommended that you add users to groups, because by managing groups you can manage multiple users more efficiently.

1. In the **Group** pane, select the group to which you want to assign users.
   
   The current assignments for the selected group are displayed in the left pane.

2. In the left pane, do one of the following:
   - To assign a user to the selected group, select the check box for the user.
   - To remove a user from the selected group, clear the check box for the user.

   To select all users in the list, click **Select All**. To deselect all users in the list, click **Unselect All**.

   The list of groups associated with each user is updated to reflect the changes.

3. Repeat steps 1 and 2 for each user that you want to assign to a group. You can assign a user to more than one group.

4. Click **Next**.

The **Assign Groups to Groups** window is displayed.

### 3.11 Assign Groups to Groups

The **Assign Groups to Groups** window prompts you to designate one group as a subgroup of another, to refine management of security for your domain.

**Note:** You should not assign groups recursively. For example, do not assign groupA as a subgroup of groupB and groupB as a subgroup of groupA.

1. In the **Group** pane, select the group to which you want to assign a subgroup.
   
   The current assignments for the selected group are displayed in the left pane.

2. In the left pane, do one of the following:
   - To assign a group, as a subgroup, to the selected group, select the check box for the group.
   - To remove a subgroup from the selected group, deselect the check box for the group.

   To select all groups in the list, click **Select All**. To unselect all groups in the list, click **Unselect All**.

   The list of subgroups associated with each group is updated to reflect your changes.

3. Repeat steps 1 and 2 for each group that you want to designate a subgroup. You can make a group a subgroup of more than one group.

4. Click **Next**.
The Assign Users and Group to Global Roles window is displayed.

### 3.12 Assign Users and Groups to Global Roles

The Assign Users and Groups to Global Roles window prompts you to assign users and groups to the global security roles defined by WebLogic Server. For a list of the default roles and the privileges that users or groups in these security roles are granted, see "Default Global Roles" in Oracle Fusion Middleware Securing Resources Using Roles and Policies for Oracle WebLogic Server.

---

**Note:** You must assign one or more users or groups (containing one or more users) to the administrator role to ensure that there is at least one user who can start WebLogic Server.

---

1. In the Role pane, select the global role to which you want to assign users and groups.
   
   The current assignments for the selected role are displayed in the left pane.

2. In the left pane, do one of the following:
   
   - To assign a user or group to the selected role, select the associated check box.
   - To remove a user or group from the selected role, deselect the associated check box.
   
   To select all users and groups in the list, click Select All. To unselect all users and groups in the list, click Unselect All.
   
   The Role list corresponding to each user and group is updated to reflect the global roles to which the user and group are assigned.

3. Repeat steps 1 and 2 for each user or group that you want to assign to a global role. You can assign a user or group to more than one global role.

4. Click Next.
   
   The Specify Start Menu Entries window displayed.

---

**Note:** If you are creating an extension template, the next window that is displayed is Prepare Scripts and Files with Replacement Variables. For more information, see Section 3.14, "Prepare Scripts and Files with Replacement Variables."

---

### 3.13 Specify Start Menu Entries

The Specify Start Menu Entries window prompts you to create items to be added to the Windows Start menu.

The next step depends on the source for the new template that you are creating.

- If you selected a domain as the source for the new template, Start menu entries are not defined. To create Start menu entries for the domain, enter the required information and click Next. The required information is defined in the following table.

- If you selected a template as the source for your custom template, the Start Menu entries from the selected template are displayed here. Review the information, and
modify it, if necessary, to meet the requirements of your domain, as described in
the following table.

Add, modify, or delete entries as required by your domain, by using the guidelines
provided in Table 3–4.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shortcut link name</td>
<td>Enter a valid name for the shortcut to be displayed in the Start menu. The</td>
</tr>
<tr>
<td></td>
<td>name must be a string of characters and it may include the space character.</td>
</tr>
<tr>
<td>Program</td>
<td>Specify the program to be run when the shortcut is selected. A list of the</td>
</tr>
<tr>
<td></td>
<td>programs defined by the template source is shown in the drop-down list. To</td>
</tr>
<tr>
<td></td>
<td>use a predefined program, select it from the drop-down list. To specify an</td>
</tr>
<tr>
<td></td>
<td>alternate program, enter the relative path to it in this field. To ensure</td>
</tr>
<tr>
<td></td>
<td>that the template is portable, you can use variables such as $USER_INSTALL_</td>
</tr>
<tr>
<td></td>
<td>DIR$ and $DOMAIN_DIRECTORY$ to specify your program path. For example:</td>
</tr>
<tr>
<td></td>
<td>$USER_INSTALL_DIR$\server\bin\installNodeMgrSvc.cmd.</td>
</tr>
<tr>
<td>Note:</td>
<td>Do not specify any executable or script that does not reside in the MW_HOME</td>
</tr>
<tr>
<td></td>
<td>directory.</td>
</tr>
<tr>
<td>Argument</td>
<td>Enter any parameter that you want to pass to the shortcut program.</td>
</tr>
<tr>
<td>Working directory</td>
<td>Enter the path of the directory from which the shortcut will be executed. If</td>
</tr>
<tr>
<td></td>
<td>you have selected a program from the drop-down list in the Program field,</td>
</tr>
<tr>
<td></td>
<td>this field is not available.</td>
</tr>
<tr>
<td>Note:</td>
<td>By default, the working directory is the directory that contains the</td>
</tr>
<tr>
<td></td>
<td>executable or script. In most cases, you do not need this field.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description for the shortcut.</td>
</tr>
</tbody>
</table>

To delete an entry, click the tab for the Start menu entry, and click Delete.
When you finish updating your settings, click Next.
The Prepare Scripts and Files with Replacement Variables window is displayed.

3.14 Prepare Scripts and Files with Replacement Variables

When you are creating a template, you want the scripts and files that you are
packaging with your template to be free of local domain environment settings and
ready for use by the Configuration Wizard. The Domain Template Builder
automatically updates any standard scripts included in a template, such as start
scripts, by replacing hard-coded values for various domain environment settings with
replacement variables. The Configuration Wizard can later replace these variables with
new hard-coded values during the configuration of a new domain.

The Prepare Scripts and Files with Replacement Variables window enables you to
replace hard-coded strings with replacement variables in files that have not been
updated by the Domain Template Builder.

| Note: | The check boxes of files that were automatically updated by the Domain Template Builder are selected. |

To insert replacement variables into your files:
1. Open the file in one of the following ways:
   - Double-click the appropriate filename in the Select File list
   - Select the appropriate filename in the list and click Edit

   The Instructions pane is replaced by an Edit File pane, in which the file is displayed. An editing toolbar is provided at the top of the Edit File pane.

2. To insert a replacement variable:
   a. Select the string to be replaced.
   b. Click the right mouse button; a list of replacement variables is displayed.
   c. Select the required variable.

   The replacement variable replaces the selected string. The Configuration Wizard later substitutes literal strings for the replacement variables to set up a specific WebLogic domain. For definitions of the available replacement variables, see Section 3.14.1, "Replacement Variable Definitions."

3. Repeat steps 1 and 2 for each string for which you want to substitute a variable.

4. Review the changes and click Save to preserve your changes, or Revert to replace the current version of the file with the last version saved. If you edited the file since the last time you saved it, you are prompted to confirm the revert operation.

   **Note:** You can also click Reset in the Select File pane to revert to the saved version of the file.

5. If you saved the edited file, select the check box next to the filename in the Select File pane.

6. Repeat steps 1 through 5 for each file in which you want to insert replacement variables.

7. Click Next.

   The Section 3.15, "Review the Domain Template" window is displayed.

### 3.14.1 Replacement Variable Definitions

The following table defines the replacement variables most commonly used in files.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADMIN_SERVER_URL</td>
<td>URL specifying the listen address (host name or IP address) and port number of the Administration Server for the domain.</td>
</tr>
<tr>
<td>APPLICATIONS_DIRECTORY</td>
<td>Directory containing the applications required by the domain. By default, the pathname for this directory is MW_HOME\user\projects\applications\domain.</td>
</tr>
<tr>
<td>BEA_HOME</td>
<td>Directory in which the products associated with the domain are installed. On a Windows system, the default path for this directory is C:\Oracle\Middleware.</td>
</tr>
<tr>
<td>DOCSWEBROOT</td>
<td>The URL specifying the location of the product documentation on the Internet.</td>
</tr>
<tr>
<td>DOMAIN_HOME</td>
<td>Directory in which the domain resides.</td>
</tr>
</tbody>
</table>
3.15 Review the Domain Template

The **Review WebLogic Domain Template** window enables you to review the settings for the new template before it is created.

1. Select an item in the **Template Summary** pane on the left and review the associated details in the **Details** pane on the right. If you need to change any settings that you defined in previous windows, select **Previous** to return to the required configuration window.

    **Note:** You can limit the type of information displayed in the **Template Summary** window by using the View drop-down list.

2. Click **Next**.

    The **Create a Template** window is displayed.
3.16 Create a Template

The Create a Template window prompts you to specify the name and directory for the domain template, and launch the process that creates it.

1. Specify a name for the template JAR file in the Template jar name field.

2. Ensure that the Template location field contains the name of the directory in which you want the template to reside.

   You can change the location either by clicking Browse and navigating to the appropriate directory or by entering the path manually.

   The template directory can be located anywhere in your system. By default, it resides in \MW_HOME\user_templates, where \MW_HOME is the directory that contains the product installation (by default, on Windows, this directory is c:\Oracle\Middleware).

3. After verifying the information displayed in the window, click Create.

   The Creating Template window displays status messages during the template creation process. The Domain Template Builder generates a JAR file that contains all the components required to generate a new domain, including the template settings that you provided.

4. Click Done in the Creating Template window.

The files included in a template vary, depending on the domain or template on which the template is based. For example, if you specify any Start menu entries in the Specify Start Menu Entries window, a startmenu.xml file that contains the specified entries is included in the template. When you create a domain by using this template, Start menu entries are created by using the values specified in this file. For more information, see "Files Typically Included in a Template" in Oracle Fusion Middleware Domain Template Reference.
Creating Extension Templates by Using the Domain Template Builder

The process for creating an extension template is similar to the process for creating a domain template, except that you are not prompted to configure the administration server, assign an administrator username and password, or specify Start menu entries, because these domain settings are already defined in the domain to be extended.

The following topics describe the steps for creating an extension template:

- Section 4.1, "Create a New Template"
- Section 4.2, "Select a Template Domain Source"
- Section 4.3, "Describe the Template"
- Section 4.4, "Add or Omit Applications"
- Section 4.5, "Add Files"
- Section 4.6, "Add SQL Scripts"
- Section 4.7, "Configuring Security Options"
- Section 4.8, "Prepare Scripts and Files"
- Section 4.9, "Review the Extension Template Settings"
- Section 4.10, "Create Your Extension Template"

4.1 Create a New Template

The Create a New Template window is displayed when you start the Domain Template Builder as described in Chapter 2, "Starting the Domain Template Builder."

Select Create an Extension Template and click Next.

The Select a Template Domain Source window is displayed.

4.2 Select a Template Domain Source

The Select a Template Domain Source window prompts you to choose the application template or domain directory from which you want to create an extension template.

To select an extension template as the source for the new extension template

1. Select the Select a Template tab.
2. From the list of templates displayed in the Templates pane, select a template.
The templates are grouped by category.

The extension templates displayed for selection are located in the directory specified in the Locate Additional Templates pane. If you want to change the directory, click Browse, and then navigate to the appropriate directory or enter the path manually.

3. Click Next.

The Describe the Template window is displayed.

To select a domain as the source for the new extension template:

1. Select the Select a Domain tab.

2. Navigate to the domain directory from which you want to create an extension template and select the desired domain.

   Valid domain directories are indicated by a Domain directory folder icon.

3. Click Next.

   The Describe the Template window is displayed.

### 4.3 Describe the Template

The Describe the Template window prompts you to provide a description for the template.

| Note: The description that you provide here is displayed in the Select a Template pane of the Select a Template Domain Source window. |

- If you selected a template as the source for the new template, information about the selected template is displayed. Review the information, and, if necessary, change it to suit the requirements of your domain. Then, click Next.
- If you selected a domain as the source for the new template, enter the information required for the domain, and click Next.

For information about the fields in the Describe the Template window, see Table 3–2.

The Add or Omit Applications window is displayed.

### 4.4 Add or Omit Applications

In this window, you can do the following:

- Review the list of applications that are currently defined in your template source.
- Review the pathnames of the current and imported applications.
- If necessary, change the relative directory into which applications are imported.
- If necessary, omit applications from the list of files to be imported.

For more information, see Section 3.4, "Add or Omit Applications."

After performing the required steps, click Next. The Add Files window is displayed.
4.5 Add Files

By default, the Domain Template Builder includes files from the domain or extension template that you specified as the source for the new extension template. In the Add Files window, you can review, add, and remove files in the template.

For more information, see Section 3.5, "Add Files."

After performing the required steps, click Next. The Add SQL Scripts window is displayed.

4.6 Add SQL Scripts

In the Add SQL Scripts window, you can add SQL scripts for each database that you expect to be used with the domains that you extend using this template. You can also specify the order in which the scripts should be executed. For more information, see Section 3.6, "Add SQL Scripts."

After performing the required steps, click Next. The Security Configuration Options window is displayed.

4.7 Configuring Security Options

Optionally, you can configure security parameters for the application resources within the domain. You can provide security for an application resource by using the following security features:

- Users and groups: Classification of individuals and groups of individuals who may be granted a security role. Typically, a group is a collection of users who share a role or function within a company, such as working in the same department.

- Global security roles: Dynamically computed privileges that are used to restrict access to WebLogic resources. These privileges are granted to or withheld from users according to the roles that they are assigned.

For example, to leverage individual skills, many Web development teams divide system administration responsibilities into distinct roles. A team may then assign a different level of permission to each role. Each project might give only one or two team members permission to deploy components, but allow all team members to view the WebLogic Server configuration.

WebLogic Server supports such role-based development by providing four default global roles that determine access privileges for system administration operations: Admin, Deployer, Operator, and Monitor.

---

**Note:** Do not make the default global security roles for administrative and server resources more restrictive. If you eliminate any existing security roles, you risk degrading WebLogic Server operation. You can, however, make the default security roles more inclusive (for example, by adding new security roles).

---

In the Security Configuration Options window, you can set security options for your application.

- If you choose No, the security settings for the new extension template are the same as the settings defined in the source template or domain.
If you choose Yes, you are prompted, in subsequent windows, to configure the security as described in Table 4–1.

**Table 4–1 Security Configuration Options Window - Parameters**

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure users, groups, and global roles</td>
<td>Define users, groups, and global roles for authentication purposes. For instructions, see Section 3.9, &quot;Configure Users, Groups, and Global Roles.&quot;</td>
</tr>
<tr>
<td>Assign users to groups</td>
<td>Assign users to groups. Groups allow you to manage multiple users at the same time. This is generally more efficient than managing each user individually. For instructions, see Section 3.10, &quot;Assign Users to Groups.&quot;</td>
</tr>
<tr>
<td>Assign groups to groups</td>
<td>Designate a group as a subgroup of another group, to add further granularity to security management. For instructions, see Section 3.11, &quot;Assign Groups to Groups.&quot;</td>
</tr>
<tr>
<td>Assign users and groups to global roles</td>
<td>Assign users and groups to predefined WebLogic Server global security roles. For instructions, see Section 3.12, &quot;Assign Users and Groups to Global Roles.&quot;</td>
</tr>
</tbody>
</table>

### 4.8 Prepare Scripts and Files

The Domain Template Builder automatically updates any standard scripts included in a template, such as start scripts, by replacing hard-coded values for various domain environment settings with variables. The Configuration Wizard can later replace these variables with new hard-coded values during the configuration of a new domain.

If you want to, you can prepare additional files to be included with your template by manually inserting replacement variables. For more information, see Section 3.14, "Prepare Scripts and Files with Replacement Variables."

After performing the required steps, click Next. The Review WebLogic Domain Template window is displayed.

### 4.9 Review the Extension Template Settings

In the Review WebLogic Domain Template window, you can review the settings for the new extension template before it is created.

1. Select an item in the Template Summary pane on the left and review the associated details in the Details pane on the right. If you need to change any settings that you defined in previous windows, select Previous to return to the required configuration window.

   **Note:** You can limit the type of information displayed in the Template Summary window by using the View drop-down list.

2. Click Next.

3. The Create an Extension Template window is displayed.

### 4.10 Create Your Extension Template

The Create an Extension Template window prompts you to specify the name and directory for the extension template, and launch the process that creates it.
1. Specify a name for the template JAR file in the Template jar name field.

2. Ensure that the Template location field contains the name of the directory in which you want the template to reside.

   You can change the location either by clicking Browse and navigating to the appropriate directory or by entering the path manually.

   The template directory can be located anywhere in your system. By default, it resides in \MW_HOME\user_templates, where \MW_HOME is the directory that contains the product installation (by default, on Windows, this directory is c:\Oracle\Middleware).

3. After verifying the information displayed in the window, click Create.

   The Creating Template window displays status messages during the template creation process. The Domain Template Builder generates a JAR file that contains only the applications and services specified in the extension template.

4. Click Done in the Creating Template window.
This section provides information and examples for some common template creation tasks:

- Section 5.1, "How Do I Create a Custom Domain Template?"
- Section 5.2, "How Do I Create a Custom Extension Template?"

### 5.1 How Do I Create a Custom Domain Template?

The following example explains how to create a custom domain template by using the Avitek Medical Records Sample Domain. A domain template defines the full set of resources within a domain, including infrastructure components, applications, services, security options, and general environment and operating system parameters. Once you have created this sample domain, you can then use this template as input to the Configuration Wizard to create a Medical Records sample domain.

**Note:** This example is based on the assumption that you have installed the WebLogic Server samples while installing the product.

1. Start the Domain Template Builder.
   - On UNIX:
     Go to the /common/bin subdirectory of the product installation directory.
     For example: `cd $MW_HOME/wlserver_<version>/common/bin`.
     Enter `sh config_builder.sh`.

2. In the Create a New Template window, select Create a Domain Template, and click Next.

3. In the Select a Template Domain Source window, do the following:
   a. Select the Select a Domain tab.
   b. Navigate to the following directory:

```
MW_HOME/wlserver_<version>/samples/domains
```

   MW_HOME is the directory in which you installed your WebLogic software, typically C:\Oracle\Middleware\wlserver_<version>.
   c. Select the medrec domain.
d. Click Next.

4. In the **Describe the Template** window, enter a name for the template.

   **Note:** If the template you are creating is to be used as the source for a new template, the information you provide in this window is displayed in the Select a Template area of the Select a Template Domain Source window.

   For this example, enter the following information.
   - **Name:** Avitek Medical Records Sample Domain
   - **Author:** Oracle Corporation
   - **Category:** Oracle
   - **Description:** Create the Avitek Medical Records domain in a directory outside of the installed kit. The Avitek Medical Records is a WebLogic Server sample application suite that concisely demonstrates all aspects of the Java EE platform.

   Click **Next**.

5. In the **Add or Omit Applications** window, you can omit applications from the template and, if applicable, change the relative path of the directory into which applications are imported. By default, all the applications in the domain are selected, indicating that they will be added to the template.

   The applications in this domain are included with the WebLogic Server software; so you cannot change the relative path of the directory into which they are imported. Because these applications reside on your system, they are not copied into the template.

   For this example, leave all applications selected, and click **Next**.

6. In the **Add Files** window, you can add or remove files from the template. By default, the following files and directories are included in the template:
   - All files in the root directory with the following extensions: .cmd, .sh, .xml, .properties, and .ini.
   - bin directory
   - lib directory
   - All files in the security directory that are not created automatically during domain creation. For example, XACMLAuthenticatorInit.ldift and XACMLRoleMapperInit.ldift are not included by default.
   - All files and subdirectories in the config directory that are not included automatically by the Domain Template Builder during template creation. For example, config.xml and any JDBC and JMS resources defined in config.xml are not displayed in the Current Template View pane by default because the Domain Template Builder includes them in the template, automatically, during template creation.
How Do I Create a Custom Domain Template?

If other files exist in your system and are required for deployed applications, you can add them in this window.

For this example, we add a patient data file that is not included by default. To add the required file, do the following:

1. In the File System View pane, select the following directory:
   medrec\incoming

2. In the Current Template View pane, select Domain Root Directory.

3. Click Add.
   The directory is added under the Domain Root Directory.

4. Click Next.

7. In the Add SQL Scripts window, you can add SQL scripts for each database that you expect to use with the domains created from this template.

   The Medical Records sample uses the default PointBase demo database included with your product installation; so you do not need to add SQL scripts in this example.

   However, you may want to use the Medical Records sample with other databases, such as Oracle or MySQL.

   To add database files for Oracle, complete the following procedure.

   a. In the Database Type and Version pane, select Oracle from the Type drop-down list, and Any from the Version drop-down list.

   b. Click Add SQL File.

   c. In the Open dialog box, navigate to the following directory:

      MW_HOME\wlserver_<version>\samples\server\medrec\setup\db

   d. From the Type drop-down list, select All Files.

   e. Shift-click to select the following two files:

      medrec_oracle.ddl
      medrec_oracle_data.sql

   f. Click Add SQL File(s).

      The names of the files that you added are displayed in the Selected SQL Files list and the Selected Database Scripts pane.

   To add database files for MySQL, complete the following procedure.

   a. In the Database Type and Version pane, select MySQL from the Type drop-down list, and Any from the Version drop-down list.

   b. Click Add SQL File.

   c. In the Open dialog box, navigate to the following directory:
How Do I Create a Custom Domain Template?

From the **Type** drop-down list, select All Files.

e. Shift-click to select the following two files:
   - `medrec_mysql.ddl`
   - `medrec_mysql_data.sql`

f. Click Add SQL File(s).
   
The names of the files that you added are displayed in the Selected SQL Files list and the Selected Database Scripts pane.
   
   Click Next.

8. In the **Configure the Administration Server** window, define the configuration information for the administration server. For more information, see Section 3.7, "Configure the Administration Server."

   In this example, leave the default values selected and click Next.

9. In the **Configure Administrator Username and Password** window, you can specify the username and password to be used to start the administration server and connect to it.

   By default, the username/password combination for the Medical Records domain is weblogic/weblogic. You can configure additional users, groups, and global roles.

   For this example, accept the default settings, and click Next.

10. In the **Specify Start Menu Entries** window, you can create entries for the Windows Start menu. In this example, you create entries to start and stop the Medical Records server.

   To create a Start menu entry for starting the Medical Records server:
   
a. Click Add.

   b. In the Shortcut link name field, enter Start Medical Records Server.

   c. From the Program field drop-down list, select `bin/startWebLogic.cmd`.

      It is not necessary to complete the remaining fields for this example.

   To create a Start menu entry for stopping the Medical Records server:
   
a. Click Add.

   b. In the Shortcut link name field, enter Stop Medical Records Server.

   c. From the Program field drop-down list, select `bin/stopWebLogic.cmd`.

      It is not necessary to complete the remaining fields for this example.

   Click Next.

11. In the **Prepare Scripts and Files with Replacement Variables** window, you can replace hard-coded strings with replacement variables in files that have not been updated by the Domain Template Builder. The Domain Template Builder automatically updates any standard scripts included in a template, such as start scripts, by replacing hard-coded values for various domain environment settings with replacement variables. The Configuration Wizard can later replace these variables with new hard-coded values during the configuration of a new domain.

12. In this example, it is not necessary to edit any additional scripts or files.
Click Next.

13. In the **Review WebLogic Domain Template** window, review the settings for the new domain template before it is created. If you need to make changes to any configuration information that you specified previously, click **Previous** to return to the required configuration window.

Click Next.

14. In the **Create a Template** window, enter a name for the template and specify a location for the template directory.

For this example, enter `my_medrec_template` in the **Template jar name** field.

By default, the template is created in `MW_HOME\user_templates`, where `MW_HOME` is the directory that contains the product installation. You do not need to change the default in this example.

Click **Create**.

15. In the **Creating Template** window, status messages are displayed during the template creation process.

Click **Done** to close the Domain Template Builder.

### 5.2 How Do I Create a Custom Extension Template?

The following example shows how to create a custom extension template by modifying the Avitek Medical Records Sample Domain extension template provided with your product installation. An extension template defines applications and services that can be used to extend an existing domain. The process for creating an extension template is similar to the process for creating a domain template except that you are not prompted to configure the administration server, assign an administrator username and password, or specify Start menu entries, because these domain settings are already defined in the domain to be extended.

In this example, you create a customized MedRec extension template in which you add support for an additional Medical Records user. Once you have created the sample extension template, you can extend an existing WebLogic domain with the Medical Records sample domain by specifying your new extension template as input to the Configuration Wizard.

To create a customized MedRec extension template, complete the following procedure:

1. Start the Domain Template Builder.
   - On Windows: From the **Start** menu, choose **Start > Programs > Oracle WebLogic > WebLogic Server > Tools > Domain Template Builder**.
   - On UNIX:
     Go to the `/common/bin` subdirectory of the product installation directory.
     For example: `cd $MW_HOME/wlserver_version/common/bin`.
     Enter `sh config_builder.sh`.

2. In the **Create a New Template** window, select **Create an Extension Template**, and click **Next**.

3. In the **Select a Template Domain Source** window, select an existing extension template or a domain from which to create an extension template. In this example, you create an extension template using the Avitek Medical Records extension template included in the product installation.
How Do I Create a Custom Extension Template?

a. Click the Select a Template tab.
   A list of the predefined extension templates provided with your product installation is displayed in the Templates pane.

b. Select the Avitek Medical Records Sample Domain extension template from the list.

c. Click Next.

4. You are using an existing template as the source for the new template; so information from the Avitek Medical Records Sample Domain extension template is displayed automatically in the Describe the Template window.
   
   For this example, you do not need to change anything.
   
   Click Next.

5. In the Add or Omit Applications window, you can omit applications from the extension template and change the relative path of the directory into which applications are imported. By default, all the applications included in the source are selected, indicating that they will be added to your custom template.
   
   For this example, you do not need to add or omit any applications.
   
   Click Next.

6. In the Add Files window, you can add or remove files from the extension template. You selected an existing template as the source for your custom template; so all files from the source template are also included automatically.
   
   In this example, the Avitek Medical Records Sample Domain extension template includes a separately defined applications directory. Therefore, the applications in the template are listed under Applications Root Directory in the Current Template View pane.
   
   Click Next.

7. In the Add SQL Scripts window, you can add SQL scripts for each database that you expect to use with the domains created from this template. Database scripts for PointBase, Oracle, and MySQL are included in the template, by default.
   
   For this example, you do not need to add any database scripts.
   
   Click Next.

8. In the Security Configurations Options window, you can customize any security settings that are defined in either your domain or the extension template that serves as the source for the new extension template.
   
   Because you are going to define an additional user in this example, select Yes, and click Next.

9. In the Configure Users, Groups, and Global Roles window, you are prompted to define users, groups, and roles for authentication purposes. The users, groups, and roles defined in the template are listed. You can select the Users, Groups, and Roles tabs to view the current definitions.
   
   In this example, you are going to define a new physician and assign the physician to an existing group.
   
   a. Make sure the Users tab is selected.
   
   b. Click Add.
   
   c. Enter the following values:
User Name: joe@md.com
User Password: weblogic
Description: MedRec Physician

By default, the new user is assigned to the Administrators group. In the next window, clear this assignment, and assign joe@md.com to the MedRec Physicians group.

d. Click Next.

10. In the **Assign Users to Groups** window, you are prompted to assign users to groups. It is recommended that you add users to groups, because by managing groups you can manage multiple users simultaneously.

In this example, you need to remove joe@md.com from the Administrators group and assign to the MedRecPhysicians group.

a. In the **Group** pane, ensure that the Administrators group is selected.

A list of current assignments for the Administrators group is displayed in the left pane.

b. In the left pane, deselect the check box for joe@md.com.

c. In the **Group** pane, select the group MedRecPhysicians.

A list of current assignments for the MedRec Physicians group is displayed in the left pane.

d. In the left pane, select the check box for joe@md.com. The list of groups associated with joe@md.com is updated to reflect the change.

e. Click Next.

11. In the **Assign Groups to Groups** window, you can designate one group as a member of another group. In this example, you do not need to change the default assignments.

Click Next.

12. In the **Assign Users and Groups to Global Roles** window, you can assign users and groups to the global security roles defined by WebLogic Server. In this example, you do not need to change the default assignments.

Click Next.

13. In the **Prepare Scripts and Files with Replacement Variables** window, you can replace hard-coded strings with replacement variables in files that have not been updated by the Domain Template Builder. The Domain Template Builder automatically updates any standard scripts included in a template, such as start scripts, by replacing hard-coded values for various domain environment settings with replacement variables. The Configuration Wizard can later replace these variables with new hard-coded values during the configuration of a new domain.

In this example, it is not necessary to edit any additional scripts or files. Click Next.

14. In the **Review WebLogic Domain Template** window, review the settings for the new extension template before it is created. If you need to modify any of the information that you defined previously, click Previous to return to the required configuration window.

Click Next.
15. In the **Create an Extension Template** window, enter a name for the extension template and specify a location for the template directory.

For this example, enter `my_medrec_ext_template` in the **Template jar name** field.

By default, the template is created in `MW_HOME\user_templates`, where `MW_HOME` is the directory that contains the product installation. You do not need to change the default in this example.

Click **Create**.

16. In the **Creating Template** window, status messages are displayed during the template creation process.

Click **Done**.